September 2010

Website: http://www.miniapples.org

Forums: http://miniapples.7.forumer.com

Email: miniapples@mac.com

From the Editor:
I was off playing boy scout this last month (National Jamboree and a weekend camping) so the
vaunted G4 has seen little action. There are several articles that have useful tips such as the one on
Five Essential Safari Extensions. I personally am using the Temperature Monitor and Right Zoom
applications. Apple has released a couple of updates for security and graphics and there is an article
about using Spotlight.
As an aside, maybe we should have a picnic like we did several years ago.
Tom Ostertag, Publications Director

Meeting Calendar
At the right is a list of
mini’app’les meetings for
Thursday
September 2010. The
Tuesday
information was compiled as
this newsletter was being
Wednesday
assembled and is subject to
Thursday
change. As always, confirm
Thursday
the Special Interest Group
Monday
(SIG) date, time, and location
with the SIG Leader or the
mini’app’les website: www.miniapples.org.

Meeting Calendar – September 2010
September 2 6:30 pm
Mac Applications SIG
September 7 7:00 pm
Mac OS X SIG
September 8 7:00 pm
VectorWorks SIG*
September 16 7:00 am Macintosh Consultants SIG
September 23 7:00 pm
FileMaker Pro SIG
September 27 6:00 pm
Mac Q&A SIG

Meeting Locations and Leaders
Meeting
FileMaker Pro SIG
Mac Applications
SIG
Mac OS X SIG
Mac Q&A SIG

Location
Partners, 2250 Terminal Rd., Roseville
Helen Young Room, Southdale Library, 7001 York
Avenue South, Edina
The Foundation, 311 7th Ave North, Minneapolis
Merriam Park Library, 1831 Marshall Ave., St. Paul

Macintosh
Consultants SIG
VectorWorks SIG*

Good Day Café, 5410 Wayzata Blvd., Golden Valley Bob Demeules, 763-559-1124
CJR Office, 4441 Claremore Dr., Edina

Leader
Steve Wilmes, 651-458-1513
Tim Drenk, 952-479-0891
Bob Demeules, 763-559-1124
Chuck Hauge, 612-963-5064

Charles Radloff, 952-941-1667

* This SIG is NOT sponsored by mini’app’les; the listing is provided as a service to members.
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Board of Directors' Meeting Minutes
9 August 2010
In attendance: Tim Drenk, Dave
Lundin, Joel Gerdeen, Kevin
Strysik, Bruce Thompson
Absent: Dave Diamont, Tom
Ostertag, Les Anderson
Other Attendees:
Agenda: See Directors’ Reports and Old and New
Business below.
Minutes: The minutes for the June 7, 2010, meeting
were approved electronically and published on
forumer.com on 14 Jun.
Directors’ Reports
Treasurer Dave Lundin’s report: All bills are paid.
A written report was distributed at the meeting. A
deposit on July 2 is being investigated further. The
budget status for 2009-10 was reviewed and a
proposed budget for new fiscal year starting Aug 1
was proposed. [Note that we did not discuss
approval.]
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President Tim Drenk’s report: Tim suggested that
we consider organizing an iOS Devices SIG. This
would focus on Apps for handheld iOS devices,
excluding those apps covered by the Mac Apps SIG.
Secretary Joel Gerdeen’s report: Joel met with
Harry Lienke on July 11 and reviewed the group
files and secretarial responsibilities.
SIG Director Kevin Strysik’s report: Kevin sent an
email message to all SIG leaders, requesting better
communication. If a meeting date change, they
should let Kevin know.
Past President Bruce Thompson’s report: When
necessary, Bruce will update the group calendar
published through the groups MobileMe account.
The Dropbox used for newsletter share will be
transferred to the main Dropbox used for sharing
other group files.
Old Business
Process for approving minutes – Tim / Joel: We
agreed that a draft of the minutes would be posted by
the Wednesday following the BOD meeting. The
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BOD would then review and comment by Friday and
the minutes would be published on the mini’app’les
forum by the following Monday. (See last months
minutes for more details.)
Renewal notice problems – Bruce: Bruce reported
that the problems with the membership renewal
process have been resolved. He is now being notified
about bouncing email renewal notifications. The
membership form was also updated to reference
PayPal payments which are now coming through.
Bylaws change to Joel – Bruce: Joel received the
updated Bylaws from Harry.
miniapples.org domain registration and hosting –
Tim: The miniapples.org domain has successfully
been moved to Bluehost.com. Dual hosts were used
for a while until the internet name server changes
propagated. Tim will also set up email accounts for
the BOD members at miniapples.org. For example,
president@miniapples.org and other officer accounts
will be established. The account
info@miniapples.org will be used for
announcements and forwarded messages from the
current mac.com accounts.
Possible Fall Saturday workshop – Bruce: The
BOD agreed that this is still a good idea, but we still
need to decide on a date and location. The Penn
Lake library has good access. This venue is good for
older systems that are not supported by Apples
Genius Bars. Bruce reminded us that the forum has a
Buy & Sell section and that this meeting would not
be used for that purpose.
New Business
New SIG leaders and SIG changes – Tim: Tim
proposed an iOS SIG as discussed above. Tim is
leading the Mac Apps SIG which has been moved to
the first Thursday of the month. The Q&A SIG
leadership is being transferred from Les Anderson to
Chuck Hauge.
New Webmaster – Tim: Dave Diamont will be the
new Webmaster. Tim will get him the info and files
for the web site.
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Next meeting: Scheduled for October 11, 2010, at
the Merriam Park Library at 6:00 pm. All club
members are welcome to attend.
The meeting was adjourned at 7:20 pm.

Q&A SIG Report • 26 July 2010
By Les Anderson
A few of the topics
from the July
Q&A SIG dealt
with EXCEL and
custom templates.
A member had
some old
templates that
were no longer
needed and could
not remove them
from his template
menu. There were also questions dealing with
an upgrade from EXCEL 4 to EXCEL 10.
A visitor had some floppies with files she
needed but could not read them with a floppy
drive she bought. It turned out that they were
800K floppies, and the newer drives only read
1.4 meg floppies. A good point to remember if
you have old files you need to access. Another
reason to keep that older MAC in the basement.
Another member wanted to draw an electronic
diagram and needed to have arrows in a
circular pattern. Lucky for us, PAGES expert,
Pam, was there to do a short demo of the
graphic options in PAGES.
Back in June I stated that I would step down by
the end of the year as the SIG leader. Chuck
Hauge will be taking over the SIG.
The Q&A SIG meets on the fourth Monday of
each month at the Merriam Park Library at
6PM.
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OSX Meeting • 6 July 2010
by Bruce Thompson
For the August OS X SIG, Bob Demeules was
out of town and our illustrious
President, Tim Drenk,
volunteered to substitute. As
usual, discussion started off
about the latest Apple
hardware. Of note to video and
graphic professionals, the Mac
Pro can now be ordered as a 12-core machine.
Talk about super computers for your desktop!
Tim then displayed the new Apple battery
charger. As with all recent Apple developments,
it is a “green” device. Its power consumption
drops significantly after the batteries are
charged. And the batteries are of a nickel-metal
hydride construction that holds its charge for an
extended period of time.
One of the reasons for the battery charger is the
new Magic Trackpad, a Bluetooth trackpad
designed to be used with desktop computers. It
provides the same Multi-Touch capabilities as
the recent laptops. It has the same profile as the
latest Bluetooth keyboard. And, we have been
told, there are ways to make it work with
Windows, should one be compelled to use that
platform.
Tim then began an examination of Finder
alternatives. One option is Macintosh Explorer.
This is a fairly old program that has a look
similar to the Windows Explorer. But there are
several limitations, including losing the
functionality of the Finder sidebar. One of the
primary reasons to consider it previously was
that it had image preview when Finder did not.
It also has some tools for changing file
information, including the ability to do batch
changes. But it has not been updated for some
time.
The other Finder replacement Tim
demonstrated is Path Finder. This is a current
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application that replicates most of the Finder
and then adds additional capabilities. Among
its many features are tab Finder windows, a
dual window setup (great for moving or
copying files), the ability to empty the Trash on
a volume by volume basis, a bookmark bar for
favorite file and folder locations, configurable
file and folder listings, and the ability to show
hidden files on either a global or folder by
folder basis. While the configurations are
somewhat scattered, the capabilities are
extensive.
At the conclusion of the demonstrations, Tim
gave away a copy of Path Finder. The lucky
winner was Joel Gerdeen.
The next meeting of the OS X SIG is scheduled
for Tuesday, Sept. 7. As a reminder, there is a
Twins game that night and parking could be at
a premium, so plan your travel and arrival time
accordingly.

Apple User Group Bulletin - August 17, 2010
From The mini’app’les Forummer
Recent Highlights from the Apple User Group
Resources website:
http://appleusergroupresources.com
• Save the Date: User Group Reunion
• Bellarine Mac User Group: Troubleshooting
Guide
• iMUG and iPad: A Winning Combo
• History… History… Is Your Group on the
List?
• Macintosh Computer Expo: Be there
• Amsterdam Final Cut Pro SuperMeet 2010
• Special Offer: 15 percent off Computer
Memory, Flash Drives and Hard Drives
• Special Offer: 25 percent off Home Inventory
• Special Offer: 20 percent off All Eltima Mac
Products
• Special Offer: 38 percent off iMedia Converter
for Mac
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• Private: Ambassador Offer: Computer
Memory, Flash Drives and Hard Drives
• Private: Ambassador Offer: Home Inventory
• Private: Ambassador Offer: iMedia Converter
for Mac
• Private: Leaders Offer: IGG Software iBank 4
Be sure to visit the special offers link to find
offers and codes on one page.
http://appleusergroupresources.com/?
page_id=653
password: resource

Five Essential Safari Extensions
by Lex Friedman
Web browsers like Firefox, Chrome, and even
Internet Explorer have offered support for addons and extras since soon after their respective
releases. Apple's own Safari browser, however,
took seven and a half years to gain support for
extensions, which arrived with the recently
released Safari 5.
Apple launched its own directory of Safari
extensions last month; before then, Jonas
Wisser's Safari Extensions blog was the easiest
place to find new extensions - but both sites can
feel a bit overwhelming. There are hundreds of
Safari Extensions, with more arriving every day,
so it can be hard to find the signal in the noise.
I've already dug up several extensions that
vastly improve my own daily Internet surfing perhaps they can help you, too.
YouTube5 -- Connor McKay's YouTube5 is one
of my favorite Safari Extensions - but don't
judge the extension by the creator's Web site.
Enabling this extension dramatically reduces
the number of Flash videos you'll encounter on
the Web. YouTube videos, whether on YouTube
itself or embedded elsewhere, will no longer
use Flash; rather, they will leverage the magic of
HTML5, which should mean much lower
processor demands (and thus less power
consumption) for your Mac.
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The YouTube5 extension includes a single
preference: you can choose the largest video
format the extension should load when
available: 360p, 720p, or full high-definition
1080p.
InvisibleHand -- Created by the eponymous
shopping site, the InvisibleHand extension
makes me happy because I love saving money.
Before I make a purchase online, I spend
considerable time searching to make sure I'm
getting the best deal possible. Or, at least, I used
to.

With InvisibleHand installed, you see a small
yellow bar across the top of some shopping
sites. That bar tells you how much you could
save if you instead purchase that product from
another source (it also tells you if you're already
at the retailer with the best price). For example,
when I looked at the iPod touch on
Amazon.com, InvisibleHand suggested that I
could buy it elsewhere for $37 less - a savings of
more than 20 percent.
When InvisibleHand works, it's awesome, and
can save you some serious coin. Unfortunately,
the extension does have a few weaknesses: You
can't configure which other online retailers it
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should search, so if you'd prefer not to see, say,
eBay price comparisons, you're out of luck.
NoMoreiTunes -- Another Safari extension that
works to eliminate one major Web-browsing
annoyance goes by the catchy name of
NoMoreiTunes. Whether you're clicking on an
iPhone or iPad app link, or an iTunes song or
movie, you always know what to expect: After
the Apple-hosted preview page loads, then
iTunes opens, and it (slowly) loads the content
you were after.
Well, that's what happened in the era before
NoMoreiTunes. Now, when I click those links, I
see Apple's preview page for the given content
(like this one) - and iTunes remains
undisturbed. It's delightfully refreshing. It
would be nice if Apple would code its iTunes
Preview Web site so it doesn't pop open iTunes
anyway, but until Cupertino comes to its senses,
NoMoreiTunes makes a great sanity restorer.
[Editor's note: It appears that Apple has indeed
come to its senses and changed this behavior on
the iTunes Web site after the initial publication
of this article, so there's no need for
NoMoreiTunes any more. -Adam]

Ultimate Status Bar -- Safari's status bar - the
strip at the bottom edge of your browser
window that displays a URL when you hover
the cursor over a hyperlink - is off by default,
but once you turn it on, it's always there. In
some browsers, like Google Chrome, the status
bar appears only when necessary when you
move your cursor over a link.

ten themes, from the subtle Classic to the
technicolor, unicorn-laden Sparkle. Beyond that,
it shows the destination URL's favicon and even
expands shortened URLs like those you'd find
on Twitter, so you can know where you're going
before you click. And the extension can even
show the size of a linked file to download.
A promising competitor called Gentle Status
Bar offers similar functionality, but hews much
more closely to Safari's own design aesthetic,
with the added benefit of reflecting when you're
holding down keys that will make the clicked
link open in a new window or tab. But it lacks
some of Ultimate Status Bar's niceties, like
revealing the favicon or file size for the link in
question.
AutoPagerize -- Many Web sites break their
articles into separate pages, to encourage extra
page views (which lead to extra ad
impressions). AutoPagerize magically makes
that extra clicking (and waiting for pages to
load) go away. Subsequent pages of the article
you're reading simply load right into the page,
waiting for you to scroll down and read them.
The Japanese developer's Web site is a bit tough
to parse, but I needed only to install the
extension to start using it successfully.
But Wait, There's More -- While those five
extensions are the ones that most regularly
impact my daily Web surfing, there are plenty
of others. John Siracusa's standalone Reload
Button, an unofficial Instapaper button called
Instafari, the Reddit-improving extension
Reddit SuperHide, and Panic Software's Coda
Notes all provide handy features and are worth
trying out. Apple's own directory includes new
extensions from big partners like Twitter, The
New York Times, and Major League Baseball;
those are certainly worth a look, too.

Ultimate Status Bar emulates that behavior,
freeing a few precious vertical pixels to show
you more of your Web pages. On top of that, the
extension offers numerous benefits over Safari's
default status bar. For one thing, you can
change its appearance; the extension includes
mini’app’les Newsletter — September 2010
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In another, not-too-distant life, I was a Web
developer. Since Safari Extensions just use
familiar bits of Web code - like HTML, CSS, and
JavaScript - I realized that I could create some
for my own purposes. To date, I've built two.
The first, Facebook Improved, removes
considerable amounts of cruft from that social
networking site - invasive ads, unnecessary
elements (that ever-present callout to create an
event), and the like. It also changes the site's
font to Helvetica, and makes subtle changes to
the placeholder text on certain fields to ensure
you never get confused about whether you're
posting on someone else's Wall or your own.
My other extension, Affiliatizer for Safari,
automatically rewrites Amazon links across the
Web so that they include the Amazon affiliate
code of your choosing. The extension, which
affects only links that don't already include
affiliate codes of their own, accepts up to three
affiliate codes, and picks one at random on each
page view. It's a nice way to reward yourself, or
a friend who has an affiliate code. By default,
the app includes my affiliate code and those of
our friends John Gruber and Jason Snell, until
you save your own preferences instead.
But ounce for ounce, no extensions benefit my
day-to-day Web surfing as much as YouTube5,
InvisibleHand, NoMoreiTunes, Ultimate Status
Bar, and AutoPagerize. Try
them out, and you'll see
for yourself how
handy these tools are
when you're on
Safari. And of course,
if you decide you
don't like what a
particular extension
does for you, just visit
the Extension pane in
Safari's Preferences window to uninstall it.
Unless otherwise noted, this article is copyright © 2010 Lex
Friedman TidBITS is copyright © 2010 TidBITS Publishing
Inc.Reuse governed by Creative Commons License.
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VMware Fusion 3.1.1
by Lex Friedman
VMware Fusion, which lets you run Windows
and other operating systems on your Intelpowered Mac, has been updated to version
3.1.1. The maintenance-focused update now
supports VMware vSphere 4.1 as a guest
operating system, enabling you to run ESX
without needing spare hardware - though this
feature is currently labeled as experimental and
the company warns against using it in
production environments. The update also
addresses an issue with some iSight cameras,
removes an incorrect disk error message after a
host crash, and corrects an issue where audio
recording worked only at 44.1 kHz. VMware
Fusion requires Mac OS X 10.4.11 or higher, and
of course a copy of Windows if you plan to
install that operating system. The download is
accessible from within VMware Fusion itself, or
from the VMware Web site. ($79.95 new, free
upgrade, 434 MB)
Unless otherwise noted, this article is copyright © 2010 Lex
Friedman TidBITS is copyright © 2010 TidBITS Publishing Inc.
Reuse governed by Creative Commons License.

GraphicConverter 6.7.4
by Lex Friedman
Lemkesoft has updated its flagship imagemanipulation tool GraphicConverter to version
6.7.4. The significant 6.7 update earlier this year
added the capability to import a variety of new
image formats, including scrap files, HMR, dm2
and dm3, and direct SVG via PDF. Also new in
6.7 was added support for the AppleScript
command "search with spotlight." Since that
release, GraphicConverter has seen a few minor
updates, adding more support for exporting
QuickTime movies, importing larger TIFFs,
exporting GIF animations as filmstrips,
importing FUJI files, integrating with the
Google Earth Safari plug-in, and the ability to
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undo actions even after changing your
selection.
The recent update to 6.7.4 adds an option to
scale after crop, PDN preview display, and a
sepia batch action. Issues with color profiles,
Unicode support, and 1080p and animation
scaling were also addressed. See Lemkesoft's
Web site for full release notes on all that has
changed since 6.7.

Spotlight to search the current Finder folder by
default, instead of This Mac. To do this, choose
Finder > Preferences, click the Advanced button, and
choose Search the Current Folder from the pop-up
menu. From then on, when you invoke the Finder's
Find command by choosing File > Find (CommandF), searches will be limited to the current folder
showing in the frontmost Finder window. This
option first appeared in Mac OS X 10.6 Snow
Leopard.

Multiple versions of GraphicConverter are
available for download; you can choose
English-only editions, PowerPC-only editions,
or the standard universal and localized edition.
($34.95 new, free upgrade, 100 MB)
Unless otherwise noted, this article is copyright © 2010 Lex
Friedman TidBITS is copyright © 2010 TidBITS Publishing Inc.
Reuse governed by Creative Commons License.

Find Files More Easily in Mac OS X
by Adam C. Engst
For some people, Apple's Spotlight technology is a
great boon, shining bright light into the dark nooks
and crannies of a hard disk. For others, particularly
those who want to search primarily by file name,
Spotlight can be annoying to use. I fall into that
latter group - I know what my documents are called,
for the most part, so if I'm looking for a document, I
almost always search by file name (when I do search
by "contents" - all file metadata, including textual
content - I'm usually disappointed).
One frequently mentioned solution to the Spotlight
problem is the freeware EasyFind from
DEVONtechnologies, which Matt reviewed in
"EasyFind 4.0: It's Easy, It Finds, It's Free" (11
October 2007). But EasyFind is relatively slow,
since it doesn't index your hard disk, and Spotlight
can be tweaked to work more the way many of us
want, with a few simple settings. There's nothing
new here, but lots of Mac users still aren't aware of
these options.
First, if you usually know roughly where the files
you're looking for are located, you can restrict
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Second, if you usually want to search by file name
instead of the file's contents, you can make sure the
Search bar at the top of the Finder window is set to
File Name without requiring an additional click.
Hold down the Shift key, and choose File > Find by
Name (Command-Shift-F). This command is
available in both Mac OS X 10.5 Leopard and 10.6
Snow Leopard.

If you want Find by Name to be your default action,
you can switch the keyboard shortcuts using the
Keyboard Shortcuts view of the Keyboard
preference pane. Just click the + button, and add
entries for "Find" and "Find by Name..." (note the
three periods - not an ellipsis - after the name) with
the appropriate keyboard shortcuts. You may have to
log out or restart for the new shortcuts to become
active, and I've found remapping shortcuts in this
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fashion to be a bit finicky, sometimes requiring
multiple tries. Again, you can do this in both
Leopard and Snow Leopard.

One last suggestion. You can adjust the look of the
search results window just like any other Finder
window, and once you've done that, the Finder
remembers it for subsequent usages. To do this, first
start a search. Once
the Finder window
has search options in
it, switch to the
desired view (I prefer
List view - choose
View > as List or
press Command-2)
and choose View >
Show View Options
to reveal the View
Options window. In
it, you can select the
"Always open in list
view" checkbox if
you desire, and you
can pick which
columns appear. I
prefer Date Modified
to the default of Last
Opened, and yes, it's
a darn shame that not
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all columns are available - notably Size. I have no
idea why Apple won't allow us to see the size,
version, comments, and labels of found items. You
can also resize columns by dragging their column
separators and rearrange columns by dragging their
headers. Once you get the window looking the way
you like, close it, and the Finder should remember its
layout next time.

A few quick caveats. If you have "Always open
folders in a new window" selected in the Finder's
General preferences, using either of the Find
commands will create a new window that defaults to
whatever location is set in the "New Finder windows
open" pop-up menu, which will likely be confusing.
I recommend deselecting the "Always open folders
in a new window" option. Also, these settings apply
only when you start the search from the Finder, not if
you use the Spotlight menu or Command-Spacebar.
If you find yourself changing Spotlight's Search bar
settings every time you look for a file, perhaps these
settings will make your life just a little bit easier.
Unless otherwise noted, this article is copyright © 2010 Adam C.
Engst TidBITS is copyright © 2010 TidBITS Publishing
Inc.Reuse governed by Creative Commons License.
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TidBITS Watchlist: Notable Software Updates
Adobe Acrobat/Reader 9.3.4 and 8.2.4 -- Adobe
has released updates to Adobe Acrobat and
Reader - for both the current 9.x versions and
the previous 8.x versions - to address a critical
security vulnerability related to TrueType font
handling. You can update using the programs'
automatic update mechanisms, but many
people, including us, have trouble with them,
so use the links provided to download the latest
version manually if need be. That said, be
warned that many people are having trouble
with the update to Acrobat 8.2.4 rendering the
program unusable - Adobe is aware of the
problem. Until a fix appears, users of Acrobat
8.x should hold off on the update or, if it's too
late, revert to 8.2.3. (Free updates, various sizes)
Pear Note 2.0.1 -- Hard on the heels of the major
2.0 release, Useful Fruit Software has released
Pear Note 2.0.1 with two notable changes to the
multimedia note-taking software. A crashing
bug that could occur when Pear Note was
updating its search cache has been fixed, and
the Web sharing layout has been improved for
very long recordings. ($39.99 new, free update,
5.0 MB)
TextExpander 3.1.1 -- Smile - née
SmileOnMyMac - has upgraded its typing
shortcut utility TextExpander to version 3.1.1.
The maintenance release fixes a couple of
serious bugs, including a potential crash and an
issue that could cause you to lose all your saved
snippets (the customizable shortcuts that you
type to trigger longer text strings). The update
also includes a fix for the Adapt to Case option.
($34.95 new, free update, 4.4 MB)
Typinator 4.1 -- Typinator 4.1 brings a slew of
fixes and improvements to the text-expansion
utility. Among them are speed boosts for Quick
Search and text file imports, clearer behavior
during installation and in-application updating,
and corrections for text expansion with Gmail
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in Firefox, Amazon's Kindle for Mac, Komodo,
and Apple Mail. Developer Ergonis Software
offers more detailed release notes. (€19.99 new,
free update, 3.2 MB)
Interarchy 10.0.2 -- Nolobe's file transfer client
Interarchy, which recently saw a major revision
to 10.0, has now been bumped to version 10.0.2
to fix more bugs discovered after the main
release. The latest bug fixes address various
issues with Net Disks, and also correct
problems with dragging and editing
bookmarks, installing the Interarchy command
line tool, and using the Open menu items. Also
included in the latest upgrade are numerous
improvements to Interarchy's Amazon S3
support. Note that this release also disables SSH
ControlMaster, which was reportedly causing
performance issues; a hidden preference key
can be used to turn it back on. See Nolobe's blog
for full release notes. ($49.95 new, free update,
6.5 MB)
Snow Leopard Graphics Update -- Apple has
released the Snow Leopard Graphics Update to
address graphics problems in games and
graphics applications. In particular, the update
addresses frame rate performance problems in
Portal and Team Fortress 2 on certain Macs, and
fixes a bug that could cause Aperture 3 and
StarCraft II to crash or freeze. Macworld is now
reporting that the update can significantly
improve graphics performance in other games
as well. It's available via Software Update or the
Apple Support Downloads page. (Free, 65.65
MB)
Keyboard Maestro 4.3.2 -- Stairways Software
has upgraded its flagship Keyboard Maestro
utility to version 4.3.2. The minor update
addresses aesthetic and functional issues alike.
On the visual side, the new version improves
the look of disabled keyboard actions to make
them more obviously disabled. On the usability
side, various tweaks improve typing
performance, correct issues with rogue
characters, and fix a crash that could occur
when referenced files were removed.
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Additionally, the release adds a configurable
command for osascript, which enables you to
execute AppleScript plug-ins as 32-bit.
Keyboard Maestro requires Mac OS X 10.5 or
higher, and a free trial is available. ($36 new,
free upgrade, 9.0 MB)
Copyright © 2010 TidBITS Staff. TidBITS is copyright © 2010
TidBITS Publishing Inc. If you're reading this article on a Web
site other than TidBITS.com, please let us know, because if it
was republished without attribution, by a commercial site, or in
modified form, it violates our Creative Commons License.

RightZoom • Blazing Tools Software
Requirements: Mac OS X 10.4 or later.
The RightZoom utility is created for people
who don't like the default behavior of the green
Zoom button in Mac OS X programs. This small
program changes its behavior, so a green button
will always maximize your windows to all
available screen space instead of inconvenient
resizing. You will also be able to maximize the
active window with Command + Option + E
keys (can be customized).
The program changes the most annoying
examples of inconvenient zoom button
behavior (Finder, Safari, MS Office, Pages etc).
You can easily extend this list with your own
applications.
Search for RightZoom on MacUpdate.

Temperature Monitor • Marcel Bresink
Software-Systeme
Requirements: Mac OS X 10.4 or later, Universal
Temperature Monitor is an application to read
out all accessible temperature sensors in
Macintosh computers. The program can
visualize the history graphs of the readings,
display measured values in a large variety of
fashions, or announce readings by speech
output. It can also store and export values.
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Temperature Monitor is the small gratis version
of the application Hardware Monitor. Hardware
Monitor can additionally display "nontemperature" sensors and artificial operating
system probes, or control external LCD panels.
Temperature Monitor is part of a software suite
of 9 different monitoring applications which
can be used for numerous purposes.
Temperature Monitor is electronically
distributed software. You can download the
product free of charge here.

Recording TV to iTunes with Elgato's EyeTV
Tuners
by Julio Ojeda-Zapata
I don't TiVo - if you'll forgive my use of the
word as a verb - but I do timeshift my TV
watching. I can't recall the last time I watched
anything live on the tube. All my favorite
shows - from "60 Minutes" and "Frontline" to
"Doctor Who," "The Big Bang Theory," and "The
Daily Show with Jon Stewart" - are recorded
and archived for future consumption.
And being a Mac nerd, I do this the Mac way.
I am a longtime user of EyeTV-tuning gizmos,
which are made by Elgato for use, primarily,
with the Mac. For years, I have depended on
my Apple computers and my EyeTV-tuning
gadgetry to convert my programs into digital
bits so I could watch them whenever and
wherever I wanted.
EyeTV devices plug into a Mac's USB port and
essentially turn the computer into a TiVo-style
device. They detect analog (NTSC) and digital
(ATSC) signals and display them on the Mac's
screen, which becomes a TV. Users then record
what they want, using EyeTV software on their
Macs to change channels, set up automated
recordings (via online TV Guide listings) and
more. Once recorded, the programs are normal
video files that can be viewed in iTunes or other
software, converted to formats that can play on
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iOS devices, or even fiddled with in video
editing software.
My love affair with Elgato's EyeTV products
has grown gradually as they have matured.
There was a time when they were awful - crude
and unreliable, with video quality that was
uniformly terrible. Much of this was not
Elgato's fault - Macs (and computers in general)
were not powerful and dependable enough to
handle the necessary video processing properly,
unlike a modern 27-inch iMac that makes a jawdropping television when Elgato-ed up. A
detailed timeline of Elgato's hardware and
software products can be found on Wikipedia.
Though Elgato products are now fantastic,
using them can result in annoying moments.
Every so often, I will overlook some little
setting or detail and a favorite program won't
be recorded. The use of Elgato gear is a
decidedly geeky kind of TV timeshifting, and
not for technophobes.
However, problems with the Elgato experience
are, once again, not always Elgato's fault. These
days, Elgato has been in a running technology
battle with the likes of the cable giant Comcast,
which is changing how its programs are fed to
viewers. Comcast's changes have forced Elgato
to adapt - which it has done very nicely.
Despite the Spanish-sounding name, Elgato is
based in Munich, Germany, but has offices in
San Francisco. The company has sterling
credentials - its founder, Markus Fest, is the
creator of the Toast disc-burning software for
Mac, and the company's product evangelist for
years (the aptly named Mike Evangelist), was
one of the key minds behind iDVD while at
Apple. (He recently took a job at Minnesotabased Code 42 Software - creators of the
frequently lauded CrashPlan online backup
software and service - as vice president of
marketing. In the interests of full disclosure,
Mike is a friend and fellow St. Paul-area
resident.)
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QAM, I Am -- Older EyeTV tuners, like the
EyeTV EZ and EyeTV Wonder, recorded only
analog signals. Later tuners, starting with the
EyeTV 250, went digital in a variety of ways. As
the age of high-definition over-the-air
broadcasts dawned, for instance, I could
connect an EyeTV tuner to a simple indoor
antenna and pull down pristine digital signals.
But I now have an even cooler trick up my
sleeve.
The roughly two dozen digital channels
available over the air are also available via my
Comcast feed, in digital form (and often in high
definition) at no cost. The channels include all
the network affiliates as well as other digital
options. My wife's beloved Spanish-language
Univisión channel is on the list, for instance.
These channels, right there for the watching by
any Comcast user who knows where to look
and has the correct gear, are known as "clear
QAM" or "in the clear" channels. Other cable
providers offer similar ones.
Getting all this free digital goodness, in my
case, is easy. All I have to do is:
1. Plug an EyeTV Hybrid tuner into a USB port
on one of my Macs.
2. Connect the coaxial cable with my Comcast
feed into the other end of the EyeTV Hybrid.
3. Fire up the EyeTV software.
4. Initiate a setup assistant to look for all those
digital channels via the coax hookup.
Like magic, the EyeTV tuner and software sniff
out all the free QAM channels and deposit them
on the channel-list section of the EyeTV 3
application. I can then associate them with TV
Guide's terrific online listings in order to set up
automatic recordings of my favorite programs.
(Only later-model EyeTV tuners, starting with
the EyeTV 500, are able to perform this trick.)
As I write this on a MacBook Pro on a Sunday
evening, "60 Minutes" in high definition is
about to begin. The EyeTV Hybrid tuner will
record it, and the EyeTV software will then
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export it to iTunes for my MacBook Pro or iPad
enjoyment. Every weekday evening, I do the
same with my wife's fave Univisión soap opera,
"Hasta Que el Dinero nos Separe" ("Until
Money Do Us Part"... don't ask).
Tuning Me, Tuning You -- This great TVrecording technology is not unique to Elgato, to
be clear. There are other Mac tuners (from the
likes of Equinux) as well as a gazillion tuners
for Windows (I like the Hauppauge ones).
Older Elgato hardware was derived from tuners
designed for Windows, in fact. Certain PCcentric tuners can even be used with Macs in
tandem with the EyeTV software.
To complete this little circle, Elgato's latest
tuner, the EyeTV Hybrid that I'm using, is
packaged with Windows drivers so it can be
used either with a Mac or in tandem with
Microsoft's Windows Media Center.
What sets Elgato apart is its Macintosh-flavored
elegance and its attention to detail. The EyeTV
software has evolved into a masterpiece of
interface design, with massive flexibility. For
instance, its Smart Guides feature lets me do
with TV recording what iTunes does with its
Smart Playlists, giving me fine control over
what gets recorded. Exporting to iTunes is, of
course, killer, since I can then do whatever I
please with the video, including transfer it to an
iPod or an iPad.

To be fair, this will usually happen because of
user error. The complexity of managing EyeTV
3 recordings means I'll inevitably make a
mistake. So when there's something important
that I want to ensure gets recorded, I've been
known to set up multiple Macs, each with an
EyeTV tuner, at different locations, to minimize
the possibility of coming up empty. Crazy, I
know, but I'd hate to screw up and miss a "V"
episode.
Adapt, Adapt, Adapt -- Elgato has had to
muster all of its ingenuity amid changing times
in the cable- and satellite-TV realms. Old ways
of recording programs using EyeTV gear are
rapidly being rendered obsolete, so Elgato has
to come up with new approaches.
Comcast, for instance, is in the process of
phasing out most of its old-style analog service
and nudging its customers toward digital
offerings. In other words, those long
accustomed to using Comcast service with a
coaxial connection directly into their TVs now
have to get cable boxes.
This creates complications for me, and for other
Elgato users.
For the longest time, I've been able to get a full
roster of analog channels, about 100 in all, the
same way I accessed those QAM channels with my Comcast connection jacked directly
into my EyeTV Hybrid tuner.

For these and other reasons, EyeTV is my
preferred means for keeping track of my
favorite programs. I can't rave about it enough.

Now Comcast has forced an unpleasant choice
on me:

I'm reminded from time to time, though, that
I'm doing all this TV stuff on a computer
instead of a simplified, idiot-proof set-top box.
With so many hardware and software variables
- not to mention the occasional kernel panic recordings occasionally won't happen as
intended and I'll be deprived of my latest show.
Failing to record my wife's latest soap-opera
episode makes me feel awful, even though she's
sweet about it.

• Do QAM as usual, with the capability to set
up automated recordings via the EyeTV
application, but give up analog channels
entirely. Boo!
• Get the full roster of analog channels on a Mac
via a set-top box, but give up QAM entirely,
along with automated EyeTV recording.
Double boo!
• Use a physical switcher to shift between the
two previous options. I loathe this since it
creates a mess of cables that is a far cry from
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the older, one-cable-into-the-EyeTV approach,
and because it puts even more burden on me
to avoid making mistakes.
Elgato, thankfully, has come up with an
alternative solution for those who have cable or
satellite set-top boxes.
Its latest device, the EyeTV HD, is not a tuner.
Instead it plugs into composite and (if
available) component ports on a set-top box to
record whatever channel the box happens to be
set to. Channel switching is done via an IR
blaster, a zapper that sits in front of the box and
works as a remote. IR blasters tend to work
well, but are prone to error, when something is
placed between the blaster and the IR receiver,
for instance, or if the blaster is knocked out of
alignment.
Your Mac becomes the brain of this Rube
Goldberg system, running the EyeTV software,
and connecting to the EyeTV HD via USB and
to the TV via DVI or HDMI (essentially using
the TV as the display). Recordings are
deposited onto the Mac's hard drive and
exported to iTunes, as usual.
The ideal Mac for this is, of course, Apple's new
unibody Mac mini with an HDMI port for
HDTV use. I tested the EyeTV HD and Mac
mini with a big, beautiful LG plasma set.
The EyeTV HD is not the most elegant
approach to TV recording and requires a bit of
fiddling, but it works for the most part. And it
goes a long way to answering the question,
"Why in the world would I connect a Mac to my
HDTV?"
The EyeTV HD solution is great in one key
respect: All shows, HD or not, on all channels,
are available for recording (limited only by the
channel packages to which you are subscribed).
The device even bypasses copy protection
associated with some programs, since recording
does not occur over the HDMI connection that
enables this annoying impediment.
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Elgato has recently started supporting iOS 4
with its iPad- and iPhone-savvy iOS app, which
functions as an extension of an EyeTV user's
Mac setup. You must first set up your Wi-Fi
router to permit EyeTV access on that network,
or via 3G or a Wi-Fi network at a separate
location. Once this is done (which is a bit of a
headache, largely due to router-configuration
complexities), EyeTV 3 recordings and even live
TV magically become viewable as Internet
video, streaming from your Mac to your iOS
device (not always smoothly, alas). You can
access record settings and show listings from
afar, too.
Elgato keeps working on the encoding end, too.
It provides a separate USB-stick device called
the Turbo.264 HD, which dramatically speeds
up video conversion (from EyeTV's format to
iTunes-friendly form, say), especially on older
Macs. A software-only Turbo.264 HD version
without hardware acceleration has just been
released.
What's next, Elgato? I am dying to know what
Elgato will come up with next.
I dislike the remote that Elgato bundles with its
tuners, for instance, and have long lobbied for a
cooler one. The logical approach to this problem
nowadays, is, naturally, an iOS 4 app to turn
one of Apple's devices into an EyeTV remote.
I'll wager Elgato is cooking up something like
that.
What about EyeTV software for Windows? Hey,
that could happen. Apple created a version of
iTunes for Windows, didn't it? I'd welcome a
Windows-based EyeTV program since most of
my Macs run Windows 7 as well as Mac OS X,
via Boot Camp. It would be fantastic for my
Macs to be fully EyeTV-capable regardless of
which operating system I happened to be using.
As I've worked on this article, I have become
increasingly amazed at how Elgato products (I
must have used a dozen or more different
EyeTV tuners over the years) have permeated
my digital existence. It's one of the reasons I feel
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so lucky to be a Mac user. TiVo does have its
fanatics, but given a choice, I'll go with a Mac
and EyeTV tuner every time.
Unless otherwise noted, this article is copyright © 2010 Julio
Ojeda-Zapata TidBITS is copyright © 2010 TidBITS Publishing
Inc. Reuse governed by Creative Commons License.

Hot Links of the Month
Compiled by Tom Ostertag

iPod/iPhone/iTunes
Paid iPhone Apps that just became free |
FreeAppAlert
iOS Security Fixes Released for Serious
Vulnerabilities | Tidbits
Apple To Hold iPod Event on September 7 |
iLounge
Plannr Review : iPhone and iPad Productivity |
MacWorld

Apple, Inc.
Apple Updates iMac Line | Apple
New iMac Is Editors’ Choice | PC
Magazine
Apple Patent Application on Detecting
'Unauthorized' iOS Device Usage Causes
Controversy | MacRumors

iPad
All iPad Competitors Will Fail, Frank Fox, Stop
the Noiz | Low End Mac
iPad Is Delicious. Apple’s New iPad TV Ad |
World of Apple

Miscellaneous
Mac Software
Apple Releases Security update 2010-005 for
OS X 10.5 and 10.6 | MacFixit
Mail: Safer, easier, more-efficient message
sending | MacFixit
Microsoft adds photo editing to Mac Office |
MacFixit
Office 2004/2008 Security Updates | Tidbits

Mac and Linux Side by Side, Simon Royal, Mac
Spectrum | Low End Mac
How to Safely Coil a MagSafe Power Cord |
Tested.com
Encrypted and obfuscated? Your P2P protocol
can still be IDed | ARS Technica
Popular Apple Support Discussions going
social, becoming Communities | MacFixit
Add Screen Grab To Stickies | MacWorld

Mac Hardware
MacBook Pro Shines in Dual Environments: |
Government Computer News
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dealmac: How to go broke saving money |
dealmac
Mac Gems : Google Earth Addresser |
MacWorld
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Members Helping Members
Need Help? Have a question the manual doesn’t answer? Members Helping Members is a group of
volunteers who have generously agreed to help. They are just a phone call or an email away. Please
call only during the appropriate times, and only if you are a current mini’app’les member and own
the software in question.
Apple II / IIGS Software & Hardware#................1
AppleWorks / ClarisWorks#...............................3, 4
Classic Macs#........................................................NV
Cross-Platform File Transfer#.............................2, 3
FileMaker Pro#.....................................................NV
iMacs#....................................................................NV
Intel-Based Macs#.................................................NV
iPhoto#.......................................................................3
iMovie#......................................................................6
iWork#........................................................................4
Mac OS Classic#........................................................3
1.
2.
3.
4.
5.
6.

Les Anderson#
Tom Ostertag#
Bruce Thompson#
Pam Lienke#
Ron Heck#
Dave Diamond#

651-735-3953#
651-488-9979#
763-546-1088#
651-457-6026#
651-774-9151#
952-232-8868#

Mac OS X#.............................................................NV
Microsoft Excel#....................................................2, 5
Microsoft Word#...................................................2, 5
Networks#.............................................................NV
New Users#...............................................................1
PhotoShop#...........................................................NV
QuarkXPress#............................................................5
Quicken#................................................................NV
QuickBooks and QuickBooks Pro#....................NV
VectorWorks#........................................................NV

anderslc@usfamily.net#
tostertag@usfamily.net#
bthompson@macconnect.com#
plienke@aol.com#
ronheck@comcast.net#
ddiamont@mac.com#

DEW
DEW
EW
DEW
DEW
DEW

D = Days, generally 9 a.m. to 5 p.m.
E = Evenings, generally 5 p.m. to 9 p.m.
W= Weekends, generally 1 p.m. to 9 p.m.
NV = No Volunteer
Please call at reasonable hours and ask if it is a convenient time for helping you. By the way, many of
these volunteers can also be contacted on our forums. We appreciate your cooperation.

Mini’app’les needs more volunteers for Members Helping Members — If you are
willing to be a Members Helping Members volunteer, please send an email message to
Membership Director Les Anderson or contact him on our forums with your name, telephone
number, contact hours, and the software and hardware areas you are willing to support.
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Mini’app’les Membership Application and Renewal Form
Membership cost is $15.00 for one year. To pay electronically using PayPal, visit the mini’app’les website.
If you prefer to pay by check, use the form below. Please make your check payable to “mini’app’les”.
Name:
Company (if mailed to):
Address:
City, State, Zip:
Phone # (home):
Phone # (work):
Phone # (cell):
Membership ID # (if renewal):
Email:
Your email address will NOT be sold, shared, or distributed. It will be used only for official mini’app’les business such as distribution
of the newsletter and membership renewal reminders.

Check if this is a change of address notice
Check if you want to volunteer
Check if you want to be added to “Members Helping Members”
Check if you were referred by a club member (if so, please give member’s name)
Please mail this application and your payment to:
mini’app’les
P.O. Box 796
Hopkins, MN 55343-0796
Thank you for your support!
Benefits of mini’app’les Membership
• Access to the mini’app’les online forums. Post questions and/or answers about issues, trouble shooting,
products, buying and selling, special events, discounts, and news about Apple and the mini’app’les club.
• Access to our Members Helping Members network of professional and advanced users of Apple technologies.
These members volunteer their time to help other members with software, hardware, and other Apple related
issues.
• A variety of Mac Special Interest Groups (SIGs) that meet each month.
• Multi-SIG meetings and workshops to help members with computer problems. You can bring your equipment
to these events and receive support from knowledgeable Mac users to help diagnose your problem(s).
• Participation in drawings for computer hardware, software, and other computer related materials.
• Discounts from vendors and manufacturers. Refer to the on-line forums for current offers.
mini’app’les Newsletter — September 2010
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mini’app’les

the minnesota apple computer users group, inc.

Introduction — This is the newsletter of mini’app’les, the
Minnesota Apple Computer Users’ Group Inc., a Minnesota
non-profit club. The whole newsletter is copyrighted © by
mini’app’les. Articles may be reproduced in other non-profit
User Groups’ publications except where specifically copyrighted
by the author (permission to reproduce these articles must be
given by the author). Please include the source when reprinting.
The mini’app’les Newsletter is an independent publication not
affiliated, sponsored, or sanctioned by Apple, Inc. or any other
computer manufacturer. The opinions, statements, positions, and
views are those of the author(s) or newsletter staff and are not
intended to represent the opinions, statements, positions, or
views of Apple, Inc., or any other computer manufacturer.
Instead of placing a trademark symbol at every occurrence of a
trade-marked name, we state we are using the names only in an
editorial manner, to the benefit of the trademark owner, with no
intention of infringement of the trademark.
Questions — Members with technical questions should refer
to the Members Helping Members section or bring their
questions to an appropriate SIG meeting. Please direct other
questions to an appropriate board member.
Dealers — Mini’app’les does not endorse specific dealers. The
club promotes distribution of information that may help
members identify best buys and service. The club itself does not
participate in bulk purchases of media, software, hardware, and
publications. Members may organize such activities on behalf of
other members.
Submissions — We welcome contributions from our
members. Perhaps you’re using new software that you just can’t
live without. Maybe you have a new piece of hardware that you
find extremely useful and of high quality. On the other hand,
you might be struggling with problematic software or hardware.
Why not share your experience with other members by writing a
product review? Doing so may steer others towards quality
products or help them avoid the problems you may be having.
Submissions must be received by the 15th day of each month to
be included in the next month’s newsletter. Please send
contributions directly to our post office box (mini’app’les, PO
Box 796, Hopkins MN 55343), or email them to
miniapples@mac.com.

Board of Directors
President

Tim Drenk
952-479-0891
timdrenk@miniapples.org

Vice President

Dave Diamond
952-232-8868
ddiamont@mac.com

Secretary

Joel Gerdeen
763-691-9105
jgerdeen@mac.com

Treasurer

Dave Lundin
715-483-3776
cdlundin@centurytel.net

Membership Director Les Anderson
651-735-3953
anderslc@usfamily.net
Publications Director Tom Ostertag
651-488-9979
tostertag@usfamily.net
SIG Director

Kevin Strysik
65l-489-4691
strysik@mac.com

Director at Large

Bruce Thompson
763-546-1088
bthompson@macconnect.com

Membership
Coordinator

Sandy Foderick
sfoderick@mac.com

The deadline for material for the next newsletter is the fifteenth
of the month. An article will be printed when space permits and,
if in the opinion of the Newsletter Editor or Publications
Director, it constitutes material suitable for publication.
This newsletter was produced using Apple’s Pages word
processor.
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